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For safety, please read this manual carefully before you use this product and keep it handy
for future reference.



Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
e NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

PCL is a registered trademark of Hewlett-Packard Company.

Solaris is a trademark or registered trademark of Sun Microsystems, Inc. in the United States and other
countries.

Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
Company Limited.

Copyright © 2001 Bluetooth SIG, Inc.
The Bluetooth Trademarks are owned by Bluetooth SIG, Inc. USA

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

» The product name of Windows® 95 is Microsoft® Windows 95.

* The product name of Windows® 98 is Microsoft® Windows 98.

* The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

» The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

» The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

» The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition

» The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

e Microsoft® Windows NT® Workstation 4.0



TABLE OF CONTENTS

Manuals for This Machine........cccccmiiiiiiiiiiie s 1
How to Read This Manual ..........cccceiiiiiiiiiimmmmrminnssssss s ssssss s 2
................................................................................................................................. 3
Setting Up the Machine on a Network.........ccccoviimeiinnismninscses s 5
Windows 95/98/Me, Windows 2000/Windows XP/Server 2003, Windows NT 4.0.....5
NEIWEKIE ...ttt e et e e e e e e e e e e e e e e e e e e e e e e eeeeeeeeeeeeeas 6
1Y = Te ] (o] o F TSSO PP PP 7
UN DX ettt ettt e et e e e e e e e e eae e e e e enne e e e annee e e e anseeeeanneeeeeante e e anneeaeanneeens 8
Printing using the IEEE 802.11b Interface ........cccoccvveiiiiiiiieee e 9
Printing using the IEEE 1394 Interface ... 10
1. Windows 95/98/Me Configuration
Configuring Windows 95/98/Me..........ccecurrirnmmrmnssmsnssssssmssssssssssssssssssssssssmssssssans 11
Printing without @ Print SEIVET.........oo e 11
Printing with a Windows 2000, Windows XP/Server 2003 or Windows NT Print Server ... 11
Configuring ProtoCols........cciveciieiiiriircscesssr s ssssssss s s s s s s snssnsssnssnns 12
Configuring TCP/IP and IPP for Printing ........cceeeeiioiiiere et 12
Configuring NetBEUI for Printing .......ooceeiiiiiiii e 13
Using SmartNetMonitor for Client ... 15
Installing SmartNetMonitor for Client ... 16
Setting Up the Printer DIAVEL .........evi i 17
Changing Port SEHNGS .....coiiiiiiiiiiie e 19
Setting Up a Client COMPULET .......ccccccmriiiiiiciemmsnns s ssssssss s sssssssssss s ssssssssssnes 20

2. Windows 2000 Configuration

Configuring Windows 2000.........ccccuurirsmmmmmsssssnsmasssssssssssssssssssssssssssnssssssssssssnssans 23
Printing without @ Print SErVer.........c.oooiiiii e 23
Printing with a Standard TCP/IP PO .........ccoiiiiieee e 23
Printing with @ LPR POrt ... 24
Printing with a Windows 2000, Windows XP/Server 2003 or Windows NT Print Server ...24

Configuring the ProtoCoIS.......cccccmiiiimmiiics s s 25
Configuring TCP/IP and IPP for Printing .........occvviiiiiiieieee e 25
Configuring NetBEUI for Printing .......ocveiiiiieieee e 26

Using SmartNetMonitor for Client..........cccooooroecereeeeceeeceeec e 28
Installing SmartNetMonitor for Client ..........ccccooeeciiiie e 29
Setting Up the Printer DIVEN .........uviiiii ottt e e nee e e 30
(01 0= TaTo [T o [ ado] d S T=Y 1 (19T - 32

Configuring LPR Port Printing........cceeveeiie e e s 33

Setting Up a Client COMPULET .......ccccccmiiiiiniiiesmmnenssssssssssssss s s sssssssssss s ssssssssssnes 34



3. Windows XP/Server 2003 Configuration

Configuring Windows XP/Server 2003..........cccceerrerererrrsssssssssssssssssssssssssssssssssssss 37
Printing without @ Print SErVer.........c.ooo e 37
Printing with a Standard TCP/IP PO .........ccooiiii e 37
Printing With @ LPR POF .....eeeeeeeee et e e 38
Printing with a Windows 2000, Windows XP/Server 2003 or Windows NT Print Server ...38

Configuring the ProtoColS........ccccmiiiimiiiccn s s 39
Configuring TCP/IP and IPP for Printing .........cocvviiiiiiieiee e 39

Using SmartNetMonitor for Client ... a1
Installing SmartNetMonitor for Client ..........cccoovcciiiie e 42
Setting Up the Printer DIVEN .........uviiiie ittt e e e 43
Changing Port SEHNGS .....coiiiiiiei e 45

Configuring LPR Port Printing.......ccceeeeiiieiie e s e s 46

Setting Up a Client COMPULET .......ccccccmiiiiiniiiesmmnenssssssssssssss s s sssssssssss s ssssssssssnes 47

4. Windows NT 4.0 Configuration

Configuring Windows NT 4.0......cccceiciiirrrecrssssssssssssss s s s ssssssssssssnsssnnnnns 49
Printing without @ Print SErVer..........cooo e 49
Printing with @ LPR POrt ... e 49
Printing with a Windows 2000, Windows XP/Server 2003 or Windows NT Print Server ...49

Configuring the ProtoCols........cccccmiiiimriics s s 50
Configuring TCP/IP and IPP for Printing .........cocvviiiiiiienee e 50
Configuring NetBEUI for Printing ......cooeeiriiieieee e 51

Using SmartNetMonitor for Client ... 53
Installing SmartNetMonitor for Client ..........cccooveciiiiie e 54
Setting Up the Printer DIVEN .........uviiiii ottt e e nee e e 55
(01 0= TaTo [T o [ ado] d S T=Y u (19T - 57

Configuring LPR Port Printing........ccceeeeiii e e s s 58

Setting Up a Client COMPULET .......cccccmriiiiiiciemmsnnssssssssssssss s sssssss s s ssssssssssnes 59

5. NetWare Configuration

NetWare 3.x - Advanced SettingsS.....cccoeeemeecece e e 62
Installing SmartNetMonitor for AAMIN .........ccoovieii e 62
Setting Up @s @ Print SEIVEr ... 63
Setting Up as a Remote PrNter ........cueiiiiii e 64

NetWare 4.x, 5/5.1, 6 - Advanced Settings..........ccceevmmmmmminnnnnssssmsmnnnnnsssssssssssenns 67
Installing SmartNetMonitor for AAMIN ... 67
Setting Up @s @ Print SEIVEr ..o 68
Setting Up as @ Remote PriNter ........cueiiiiiii e 71

Setting Up a Client COMPULET .......cccccmriiiiiiiieemmrnnssssssssssssss s s sssssssssss s sssssssssnnes 75
WINAOWS 95/98/ME......ceeeeiiiiiiee ettt ees 75

Windows 2000/XP/Server 2003, WIiNdOWS NT 4.0 .....ccouuiiiiiieeieeeeeee e eeeae s 76



6. Macintosh Configuration

Configuring Macintosh.............ceeiiiiiiiiic e s 79
Changing to EtherTalK .........oceiiiiiiee e 79
Configuring the PHNTEr ......ooi e 80
Changing the Printer Name.......ccooi it 80
Changing the ZONE........coi i e e e e e e e e e e eas 80

7. Appendix

Using SmartNetMonitor for Admin........ccccereimimnicmmirnss s 81
Changing the Network Interface Board Configuration...........c.cccceevviieeiiiee e 82
Displaying Maching Status............oooiiiiiiii e 83
Locking the Control Panel MEeNU ...........oociiiiiiiieeiee e 83
Selecting the Paper TYPe .....eco it 84
Managing the User INformation ............cooieiiiiiiiii e 84
Viewing and Deleting Spool Print JODS .........cocooiiiiiiiiiiiie e 85
Managing Address INfOrmation ... 85
Configuring the Energy Save MOE ..........cccciiiiiieiiiiiiee e 86

Configuring the Network Interface Board with a Web Browser ............ccceuees 87
GoiNG 10 te TOP PaGE ....eeieiiieieeie e 88
Types of Menu Configuration and MOde ...........ccooiiiiiiiiiiiii e 89
Verifying the Network Interface Board Settings ........cccccovevieiiiiiiiiiie e 90
Configuring the Network Interface Board Settings ...........ccccevvieviinieeeniseeee e 90
Using Help on the Web BroWSEr ........ocvviiiiiiiieeeeeeeeee e 91

Monitoring and Configuring the Printer.........cccciiniccmissccss e 92
Changing Names and COMMENTS .........ceeiiiiiiiiiiieeiiiee e 92
Displaying the Status of Printer..........oo e 95

Using the IEEE 802.11b (Wireless LAN)......ccccciviiiimmmmmmminnnsissssesns s ssssssssssses 98
Setting IEEE 802.11b (Wireless LAN).......uuiiiiiei e cieiee e esveee e e e eee e 98
Using in INfrastruCture MOUE ........ueeeiiiiiiiie e e e e 99
USIiNG iN Ad NOC MOAE ...t e e e e e e e e e e e e 99
Confirming the CONNECHION.........cocuiiiiiiee e 100
When Moving the Machine.............oooiiii e 101

Remote Maintenance by telnet ............o e 102
L L3 o 1= =) PSP 102
ComMMANAS LiST ..o e 103

£ 124

Understanding the Displayed Information .........ccccccmrmiiniiiisemsmsnnnssineennnnenns 125
Print JOD INfOrM@tion .........ooiiii e 125
Print Log INformation ..o 125
Configuring the Network Interface Board............ccccovveeeiiiieeiiieee e 126

MeSSAQEe LiSt ... e —————— 130
System Log INFOrMation .........cooicuieiieeiiicieiee et e e e e e e 130



o (=Y o= 111 1o - 137

Connecting a Dial-Up Router to a NetWork .........cccoovieeeiiiiee i 137
PostScript Printing from WINAOWS ..........ceeiiiiiiiiiie e 138
NEtWare Printing ... e e 138
USING DHECP ...ttt n e nae e nne s 139
Configuring @ WINS SEIVEI ......cooiiiii ittt 141
When Using the NIB Setup TOOI ........ooeiiiiiiiiiiiie e 142
When Using IPP with SmartNetMonitor for Client...........ccccoceceeve i 142
£33 o =TT 1T 1 T o 1= 143



Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

% Quick Installation Guide
Describes how to install the printer.

< Setup Guide
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

« Printer Reference
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Operating Instructions”.

« Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions” (this manual).

< PostScript 3 Operating Instructions Supplement

Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

& Note
O There are three CD-ROMs that come with this printer. "Operating Instruc-

tions", "Printer Drivers and Utilities", and "Document Management Utility".

O Concerning UNIX information, please visit our web site or consult your au-
thorized reseller.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

& Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.
Keys on the computer's keyboard.



This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Windows 2000,

Windows XP/Server 2003,
Windows NT 4.0 (Server)

% - NetWare (Server)
. S
JJ

| @m
Windows 2000 \a \I /\
Windows XP/ Eii
Server 2003 N -
Windows NT 4.0 @|
NetWare @2 /

(Client)

ﬂlmportant

O The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

/O Reference

For more information about configuring the Network Interface Board with
the control panel, see the Setup Guide.

< Features
* Support for 100BASE-TX, 10BASE-T, IP over 1394 and IEEE 802.11b.

e The Network Interface Board is compatible with NetWare "' (IPX/SPX,
TCP/1P), Windows NT 4.0 (TCP/IP, NetBEUI 2, IPP ?), Windows 2000
(TCP/IP, NetBEUI 2, IPP *?), Windows XP/Server 2003 (TCP/IP, IPP ),
Windows 95/98/Me (TCP/IP, NetBEUI 2, IPP ), UNIX (TCP/IP) and
Macintosh (AppleTalk) protocols. This allows you to use the machine in a
network that uses different protocols and operating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.



e The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

"1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc
mode.

"2 To use NetBEUI, use the SmartNetMonitor for Client port.

3 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

< Interface supported protocols

Interface
Ethernet IEEE 802.11b IEEE 1394
(IP over 1394)
Protocol TCP/IP O O @]
NetBEUI ©] O X
NetWare ) o X
AppleTalk O] O X

O means that the protocol is supported.
x means that the protocol is not supported.

"1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc
mode.



Setting Up the Machine on a Network

Windows 95/98/Me, Windows 2000/Windows XP/Server 2003,
Windows NT 4.0

For setting up the machine as a network printer in Windows 95/98/Me, Win-
dows 2000/ Windows XP/Server 2003 and Windows NT 4.0 environment.

See p.11 “Windows 95/98 /Me Configuration”.

See p.23 “Windows 2000 Configuration”.

See p.37 “Windows XP/Server 2003 Configuration”.
See p.49 “Windows NT 4.0 Configuration”.

< Printing Without a Print Server

TCP/IP TCP/IP TCP/IP TCP/IP
NetBEUI NetBEUI PP NetBEUI
PP PP LPR PP

1 7 G 1 G
Windows 95/98/Me ~ Windows 2000  Windows XP/Server 2003 Windows NT 4.0

< Printing With a Windows 2000, Windows XP/Server 2003 or Windows NT 4.0 Print Server

Windows 2000, Windows XP/Server 2003 or
Windows NT 4.0 Server (or Workstation)
Print Server

Windows 95/98/Me Windows 2000 Windows XP/Server 2003 Windows NT 4.0



NetWare

For setting up the machine as a network printer in a NetWare environment, see
p-61 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
* See p.75 “Windows 95/98/Me” .
* See p.76 “Windows 2000/ XP/Server 2003, Windows NT 4.0” .

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Print Server NetWare
File Server

g & >

Windows 95/98/Me Windows 2000  Windows XP/Server 2003 Windows NT 4.0

&

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x
See p.63 “Setting Up as a Print Server”.

e NetWare4.x,5/5.1, 6
See p.68 “Setting Up as a Print Server”.



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

Remote Printer NetWare NetWare
~ Print Server File Server
I &
S S

8 8 8 g

Windows 95/98/Me Windows 2000 Windows XP/Server 2003 Windows NT 4.0

&

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x
See p.64 “Setting Up as a Remote Printer”.

e NetWare4.x,5/5.1,6
See p.71 “Setting Up as a Remote Printer”.

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p-79 “Macintosh Configuration”.

AppleTalk

S

Macintosh



UNIX

Concerning UNIX printing information, please visit our Web site or consult your
authorized reseller.

TCP/IP

&

UNIX



Printing using the IEEE 802.11b Interface

This section describes how to print after installing the optional 802.11b Interface
Unit.

There are two methods of using this machine as a network printer with IEEE
802.11b.

< ad hoc mode

This is the mode for transmitting between each wireless LAN client. You
must make the channels the same for each wireless LAN client to transmit us-
ing this basic transmitting method which does not require an access point. See
p-98 “Using the IEEE 802.11b (Wireless LAN)”.

+ infrastructure mode

This is the mode for transmitting via an access point. If an SSID "' and WEP
2 are set in the access point, you must set the same values for the access point
and IEEE 802.11b. By connecting the access point to Ethernet, you can trans-
mit the current network environment. See p.98 “Using the IEEE 802.11b
(Wireless LAN)”.

"1 This is called a Service Set ID and is used in the connection between the wireless
LAN client and the access point. Only a wireless LAN client and an access point
that have the same SSID can transmit to each other. (The character strings to be set
are in the range ASCII 0x20-0x7e and the SSID is case-sensitive to 32 bytes.)

This is used to protect coded wireless data transmission. To transmit between
wireless LAN clients and the coded access point, you must set the same WEP key
as the printer. (You can set only 10 hexadecimal characters.)

*2

<+ad hoc mode ssinfrastructure mode

access point
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Printing using the IEEE 1394 Interface

This section describes how to print via the IEEE 1394 interface after installing the
1394 Interface Unit Type 4510.

There are two methods of using the machine as a network printer with IEEE
1394.

< SCSI print
You can print using the SCSI print device provided by Windows 2000 and
Windows XP/Server 2003. For more information, see "IEEE 1394 Configura-
tion” in the Setup Guide.

< IP over 1394
You can print by setting the IP address for this machine and the computer on
which Windows XP/Server 2003 is installed. For more information, see “IEEE
1394 Configuration” in the Setup Guide and p.37 “Printing with a Standard
TCP/IP Port” in the Windows XP/Server 2003 Configuration.

SCSl print
IP over 1394

S



S
1. Windows 95/98/Me
Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98 /Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows XP/Server 2003, Windows NT Server, Windows NT Work-
station, or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e PP
¢ NetBEUI

ﬂ Configure the chosen protocol.
¢ See p.12 “Configuring TCP/IP and IPP for Printing”.
¢ See p.13 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Windows 2000, Windows XP/Server 2003 or
Windows NT Print Server

See p.20 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000, Windows XP/Server 2003 or Windows NT print server.

11
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Windows 95/98/Me Configuration

Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

A Reference
For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.139 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Enable the use of the command prompt as follows:

e On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [Command Prompt].

e On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring Protocols

Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

ﬂ Open [Control Panel] and then double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

& Note
O If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP /IP protocol, see
Windows 95/98/Me Help.

O Under Windows Me, if you want to use IEEE 1394 (IP over 1394), make
sure TCP/IP is bound to the IEEE 1394 adaptor being used. The following
message appears:

TCP/IP -> (IEEE 1394 adaptor in use)

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.

13
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Windows 95/98/Me Configuration

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI” is listed in the [The following network components are installed:]
box on the [Configuration] tab.

& Note
O If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

O If “NetBEUI —Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

ﬂ Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and then click [Properties].

B Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
then click [OK].

ﬂ Click [OK] to close the [Network] dialog box.

B When the message to restart appears, click [Yes].



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-

fectively. It is useful in environments where two or more network printers are u
used. It is recommended that you install SmartNetMonitor for Client to use Par-

allel Printing and Recovery Printing. For more information about SmartNet-

Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

15
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Windows 95/98/Me Configuration

Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.17 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Details] tab, and then make sure that the SmartNetMonitor for
Client port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].
O ciick [Delete Port].

B Click the SmartNetMonitor for Client port name as in step ], and then click
[OK].

The port is deleted.
B Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The SmartNetMonitor for Client settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

g On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.
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ﬂ After the confirmation message, click [Yes].
B Acknowledge the [Question] dialog box.
E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click [SmartNetMonitor] from the list, and then click [OK].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.

17
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NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address], and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For more information about the printing of the configu-
ration page, see “Printing a Configuration Page” in the Setup Guide. The
NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration
page. Type the printer's network path name in the form of "%%Computer
name \Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these settings, see SmartNetMonitor for
Client Help.

A ciick [ox.
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-

lowing Port] box, and then click [OK].
This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

O You can configure Timeout Settings for the TCP/IP protocol.

ﬂ From the [Printers] window, click the printer icon. On the [File] menu, click
[Properties].

g Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.

19
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows XP/Server 2003, Windows NT Server or Win-
dows NT Workstation as a print server.

When using a Windows 2000, Windows XP/Server 2003 or Windows NT print
server, select a shared printer on Windows 2000, Windows XP/Server 2003 or
Windows NT.

Windows 2000,

Windows XP/Server 2003 or
Windows NT 4.0 Print Server

(7]
Windows 95/98/Me

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP/Server 2003 or Windows NT print
server. Do not begin the following procedure until the client has been set up
and configured correctly.

ﬂ Install the printer driver as a local printer.

/O Reference

For more information about installing the printer driver, see the Setup
Guide.

@ Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].
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B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

ﬂ Click the [Details] tab, and then click [Add Port].
B Click [Network], and then click [Browse].

E On the network tree, double-click the name of the computer used as the
print server.

The printers connected to the network are displayed.
ﬂ Click the name of the printer you want to use, and then click [OK].
B click [0k,

ﬂ Make sure that the port name is displayed in the [Print to the following port]
box, and then click [OK].

2]
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2. Windows 2000
Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP/Server 2003, Windows NT Server, Windows NT Worksta-
tion or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e PP
¢ NetBEUI

ﬂ Configure the chosen protocol.
¢ See p.25 “Configuring TCP/IP and IPP for Printing”.
* See p.26 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

& Note

O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".
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Printing with a LPR Port

See p.33 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000, Windows XP/Server 2003 or
Windows NT Print Server

See p.34 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000, Windows XP/Server 2003 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.139 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

B Make sure that the”“Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.
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Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

BMake sure that the”NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the NetBEUI protocol box if it is not already selected.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.30 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
@ select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step [}

B Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and then click [Change/Remove].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].
ﬂ Click [SmartNetMonitor for Client] in the [Available port types:] box, and then

click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

&P Note

O Printers that respond to an IP broadcast from the computer will be dis- g
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see "Printing a Configuration Page" in the Setup
Guide. The NetBEUI address appears as "\ \RNPxxxx\xxx" on the con-
figuration page. Type the printer's network path name in the form of
"%%Computer name \Share name". Do not type "\\" as head characters
but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note
O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears

¢ For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.

¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note

O For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

@ Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.25 “Configuring TCP/IP
and IPP for Printing”.

B cick [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled. For more information about how to install "Print Services for Un-
ix", see Windows 2000 Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

 click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP/Server 2003, Windows NT Server or Win-
dows NT Workstation as a print server.

When using a Windows 2000, Windows XP/Server 2003 or Windows NT print
server, select a shared printer on Windows 2000, Windows XP/Server 2003 or
Windows NT.

Windows 2000,
Windows XP/Server 2003 or
Windows NT 4.0 Print Server

@
Windows 2000

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP/Server 2003 or Windows NT print
server. Do not begin the following procedure until the client has been set up
and configured correctly.

Use the [Printers] window to set up the printer.
ﬂ Click [Start], point to [Settings] and then click [Printers].

B) Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and then click [Next >].
B Click [Next >].



Setting Up a Client Computer

B In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
ﬂ Click the printer you want to use, and then click [Next >].

@ Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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L
3. Windows XP/Server 2003

Configuration

Configuring Windows XP/Server 2003

Printing without a Print Server

The following procedure describes how to configure Windows XP/Server 2003
to use the machine on a network without a Windows 2000 Server, Windows 2000
Professional, Windows XP/Server 2003, Windows NT Server, Windows NT
Workstation or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e PP

ﬂ Configure the protocol.
¢ See p.39 “Configuring TCP/IP and IPP for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows XP/Server 2003 to enable
Peer-to-Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows
XP/Server 2003 Help.

& Note

O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".
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Printing with a LPR Port

See p.46 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000, Windows XP/Server 2003 or
Windows NT Print Server

See p.47 “Setting Up a Client Computer” for configuring Windows XP/Server
2003 with a Windows 2000, Windows XP/Server 2003 or Windows NT print
server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows XP/Server 2003 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.139 “Using DHCP”.
To use the IP over 1394, see the Setup Guide.

& Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [All Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows XP/Server 2003 computer

Follow these steps to configure a Windows XP/Server 2003 computer to use the
TCP/IP protocol.

ﬂ Click [Start] on the taskbar, point to [Control Panel], and then click [Network
and Internet Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

& Note
3 With the IP over 1394, click [1394 Connection].

B Make sure that the“Internet Protocol (TCP/IP)” is selected in the [This con-
nection uses the following items:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install...] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows XP/Server 2003 Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

* Installed options (e.g. Paper tray unit)

¢ Size and orientation of paper in each paper tray unit
¢ Total memory

* Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

A Reference
For more information about how to use SmartNetMonitor for Client, see
the "readmeXP.txt" file included on the CD-ROM labeled "Operating In-
structions" (If the CD-ROM drive is D, the folder will be
"D: etwork etmonClientDisk1").
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.43 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
@ select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step [}

B Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Add or Remove Programs]category, click [SmartNetMonitor for Client],
and then click [Change/Remove].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer. 43
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

@ Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.



Using SmartNetMonitor for Client

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
e For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.
* For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

@ Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.39 “Configuring TCP/IP
and IPP for Printing”.

ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled. For more information about how to install "Print Services for Un-
ix", see Windows XP/Server 2003 Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

 click [Close].

8 Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP/Server 2003, Windows NT Server or Win-
dows NT Workstation as a print server.

When using a Windows 2000, Windows XP/Server 2003 or Windows NT print
server, select a shared printer on Windows 2000, Windows XP/Server 2003 or
Windows NT.

Windows 2000,

Windows XP/Server 2003 or
Windows NT 4.0 Print Server

Ni
Windows XP/Server 2003

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP/Server 2003 or Windows NT print
server. Do not begin the following procedure until the client has been set up
and configured correctly.

Use the [Printers] window to set up the printer.
ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

ﬂ Click [Add Printer] in the Printer Tasks category.
This launches the Add Printer Wizard.

B ik Next >].

ﬂ Click [A network printer, or a printer attached to another computer.], and then click
[Next >].

B crick Next >1.
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B In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
ﬂ Click the printer you want to use, and then click [Next >].

@ Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a Windows XP/Server 2003 printer driver on the CD-ROM la-
beled “Printer Drivers and Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



.
4. Windows NT 4.0

Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP/Server 2003, Windows NT Server, Windows NT Worksta-
tion or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e PP
¢ NetBEUI

ﬂ Configure the chosen protocol.
¢ See p.50 “Configuring TCP/IP and IPP for Printing”.
¢ See p.51 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a LPR Port

See p.58 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000, Windows XP/Server 2003 or
Windows NT Print Server

See p.59 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000, Windows XP/Server 2003 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.139 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been correctly set.

@ Click [Start], point to [Programs], and then click [Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring the Protocols

Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP /IP pro-
tocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “TCP/IP Protocol” is listed in the [Network protocols] box on the [Proto-
cols] tab.

& Note

O If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

B Click the [Services] tab, and then make sure that “Microsoft TCP/IP Print-
ing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.
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Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and then change the
LAN adapter number (Lana Number).

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI Protocol” is listed in the [Network Protocols] box on the [Proto-
cols] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

ﬂ Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and then click [Properties].

B Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and then click [Edit].

ﬂ Type “0” as the Lana Number.

& Note

O If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number a number other than “0”.

B click [0k
E Click [Close], and then close the [Network] dialog box.
ﬂ After checking the message to restart, click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

 Prints documents using other printers in the printer group when the spec- a
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note
O Failure to meet any of the conditions above may result in unexpected
print results.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see SmartNetMonitor for Client Help.
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.55 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].

A click [Apply].
The port which is currently in use is changed.

B ciick [pelete Port].

E After the confirmation message appears, click [Yes].
The port is deleted.

ﬂ Click [OK] to close the printer properties.



Using SmartNetMonitor for Client

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ On the [Install/Uninstall] tab, click [SmartNetMonitor for Client] and click [Add/Re-
move].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After a confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor] from the list, and then click [New Port...].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.

Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see "Printing a Configuration Page" in the Setup
Guide. The NetBEUI address appears as "\ \RNPxxxx\xxx" on the con-
figuration page. Type the printer's network path name in the form of
"%%Computer name \Share name". Do not type "\\" as head characters
but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.



Using SmartNetMonitor for Client

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k

ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].
This completes the settings.

To print, select the printer specified here. SmartNetMonitor for Client will
now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server settings and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Port Configuration].
The [Port Settings] dialog box appears

¢ For TCP/IP protocol, you can configure Recovery Printing, Parallel Print-
ing and Timeout Settings.

¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note

O For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see p.50 “Configuring TCP/IP
and IPP for Printing”.

B cick [Start], point to [Settings], and then click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd] box.

B Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

 click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].



Setting Up a Client Computer

Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP/Server 2003, Windows NT Server or Win-
dows NT Workstation as a print server.

When using a Windows 2000, Windows XP/Server 2003 or Windows NT print
server, select a shared printer on Windows 2000, Windows XP/Server 2003 or
Windows NT.

Windows 2000,

Windows XP/Server 2003 or
Windows NT 4.0 Print Server

Syl
N
Windows NT 4.0

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP/Server 2003 or Windows NT print
server. Do not begin the following procedure until the client has been set up
and configured correctly.

Use the [Printers] window to set up the printer.
ﬂ Click [Start], point to [Settings], and then click [Printers].

B) Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Network printer server] and click [Next >].

ﬂ In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.
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B Click the printer you want to use and click [OK].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK] and follow the instruc-
tions on the screen.

O There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

E Select if you want to use this printer as the default printer, and then click
[Next >].

[ After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

NetWare must be set to active using the machine's control panel. For more infor-
mation about how to set it, see the Setup Guide.

< SmartNetMonitor for Admin

To use a printer in a NetWare environment, configure the NetWare printing
environment using SmartNetMonitor for Admin.

9 Note

O If you configure the NetWare printing using SmartNetMonitor for Admin
under the following environments, Novell NetWare Client is required:

e NDS mode in Windows 95/98/Me

¢ NDS or Bindary mode in Windows 2000/ XP/Server 2003/Windows
NT 4.0

O Use the version of Novell Client provided with your operating system, or
the latest version.

« Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers connected to the net-
work.
If you cannot find the printer on the displayed list, refer to the configuration
page printed on the printer. For more information about printing a configu-
ration page, see Printer Reference provided as a PDF file on the CD-ROM la-
beled “Operating Instructions”
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Basic Procedure

( Install SmartNetMonitor for Admin ]

Print Server Remote Printer

(Configure Network Interface Board ]

( Configure NetWare )

Turn the power Start the print server

off and on

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Installing SmartNetMonitor for Admin

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see “Installing the SmartNetMonitor for Client/Admin” in the Setup Guide.

After installing SmartNetMonitor for Admin, go to p.63 “Setting Up as a Print
Server” to use this computer as a print server, or to p.64 “Setting Up as a Remote
Printer” to use it as a remote printer.



NetWare 3.x - Advanced Settings

Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run SmartNetMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].
A list of printers appears.

@ Note

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions”

O If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

B click Wizard], and then click [OK].

B Enter the device name in the [Device Name] box, a comment in the [Comment]
box if necessary, and then click [Next>].

ﬂ Select the [NetWare] check box, and then click [Next>].

8 Click [Bindery Mode], enter the file server name in the [File Server Name:] box,
and then click [Next>].

In the [File Server Name:] box, enter the name of the file server in which the
print server is to be created. You can also select a file server from the list that
appears by clicking [Browse].

g Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, and the print queue name in the [Print Queue Name]
box, then click [Next>].

* In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

¢ In the [Printer Name] box, enter the name of the NetWare printer.

* In the [Print Queue Name] box, enter the name of the print queue to be added
to NetWare.
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[m After confirming the settings, click [Next>].
The settings take effect, and NIB Setup Tool closes.

ﬂ] Exit SmartNetMonitor for Admin.
m Turn the printer power off and on.

& Note

O To check the printer is configured correctly, enter the following after the
command prompt:

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or the equivalent of a Supervisor.
ﬂ Run the SmartNetMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].
A list of printers appears.

& Note

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions”

O If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

B Click [Property Sheet], and then click [OK].

B Click the [NetWare] tab, and then make the following settings:
© In the [Print Server Name] box, enter the name of the print server.

@ In the [File Server Name] box, enter the name of the file server in which a
print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [Print Server Operation Mode] group, click [As Remote Printer].
O In the [Remote Printer No.] box, enter the printer number.

ﬂlmportant
O Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

ﬂ On the [NIB] menu, click [Exit] to exit NIB Setup Tool.

B Enter “PCONSOLE” after the command prompt.
F:> PCONSOLE

g Create a print queue as follows:

& Note
O If you use a currently defined print queue, proceed to step .

@ On the [Available Options] menu, click [Print Queue Information], and then
press [Enter]).

@ Press [INSERT), and then enter a print queue name.
@ Press [ESC] to return to the [Available Options] menu.

[E Create a printer as follows:

@ On the [Available Options] menu, click [Print Server Information], and then
press [Enter].

@ To create a new print server, press [INSERT], and then enter a print server
name.

If you are using a currently defined print server, select one of the print
servers shown in the [Print Server] list.

ﬁlmportant
O Use the same name as that specified in NIB Setup Tool. (Step @ - @).

©® On the [Print Server Information] menu, click [Print Server Configuration].
O On the [Print Server Configuration] menu, click [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

ﬁlmportant
O Use the same number as that specified as the Remote Printer No. using
NIB Setup Tool. (Step @ - @).

O 1f you want to change the name of the printer, enter a new name.

The name “Printer x” is assigned to the printer. The “x” stands for the
number of the selected printer.

65



66

NetWare Configuration

@ For type, click [Remote Parallel, LPT1].

IRQ, Buffer size, Starting form, and Queue service mode are automatically
configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menu].

ﬂ] Assign print queues to the created printer as follows:

@ From [Print Server Configuration Menu], click [Queues Serviced By Printer].

@ Select the printer created in step ).

© Press the [INSERT] key to select a queue serviced by the printer.
& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.
When you have finished the above steps, check the queues are assigned.

mPress the [ESC] key until “Exit?” appears, and then click [Yes] to close
PCONSOLE.

[B Start the print server by entering the following from the console of the Net-
Ware Server:

If it is running, restart it after exiting it.
% To exit

CAREE: unload pserver
% To start

CAREE: load pserver print server name

& Note
O If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1, 6 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1, 6 envi-
ronment.

« To use NetWare 5/5.1, 6

¢ Use the printer as a print server.
Do not use as a remote printer.

¢ If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see “Configuring the
Printer for the Network” in the Setup Guide.

Basic Procedure

[ Install SmartNetMonitor for Admin j

Print Server Remote Printer

[Configure Network Interface Board J

( Configure NetWare )

Turn the power Start the print server

off and on

Installing SmartNetMonitor for Admin

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see “Installing the SmartNetMonitor for Client/Admin” in the Setup Guide.

After installing SmartNetMonitor for Admin, go to p.68 “Setting Up as a Print
Server” to use this computer as a print server, or to p.71 “Setting Up as a Remote
Printer” to use it as a remote printer.
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Setting Up as a Print Server

ﬂlmportant
O You must set up the print server using NDS mode in NetWare 4.x, 5/5.1, 6.

ﬂ Log on to the file server as a Supervisor or the equivalent of a Supervisor.
g Run SmartNetMonitor for Admin.

Bl On the [Group] menu, point to [Search Device], and then click [IPX/SPX] or
[TCP/P].

A list of printers appears.

& Note

O If you use Pure IP, click [TCP/IP].

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions” .

O If no printer name appears in the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

& Note

O If you use Pure IP, see p.70 “Using Pure IP in the NetWare 5/5.1, 6 envi-
ronment”.

B click [Wizard], and then click [OK].

E Enter the device name in the [Device Name] box, a comment in the [Comment]
box if necessary, and then click [Next>].

ﬂ Select the [NetWare] check box, and then click [Next>].
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8 Click [NDS Mode], enter the file server name in the [File Server Name:] box, the
NDS tree name in the [NDS Tree:] box and the context in the [NDS Context:]
box, and then click [Next>].

In the [File Server Name:] box, enter the name of the file server in which the
print server is to be created. You can also select a file server from the list that
appears by clicking [Browse].

By clicking [Browse], you can select a NDS context from those listed in the
[Browse] dialog box.

For context, object names are entered from a lower object and divided by a pe-

riod. For example, if you want to create a print server into NET under DS, en-
ter “NET.DS”.

g Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, the print queue name in the [Print Queue Name] box,
and the print queue volume in the [Print Queue Volume], and then click
[Next>].

¢ In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

¢ In the [Printer Name] box, enter the name of the NetWare printer.

* In the [Print Queue Name] box, enter the name of the print queue to be added
to NetWare.

* In [Print Queue Volume], enter the print queue volume. As a volume, object
names are entered from a lower object and divided by a period. You can
select a volume by clicking [Browse].

[m After confirming the settings, click [Next>].
NIB Setup Tool completion screen appears.

m Click [Finish].
The new settings are applied, and NIB Setup Tool closes.

m Exit SmartNetMonitor for Admin.

[B Turn the printer power off and on.

@ Note

O To check the printer is configured correctly, enter the following after the
command prompt:

F:> NLIST USER /A/B

O If the printer works as configured, the name of the print server appears as
an attached user.
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Using Pure IP in the NetWare 5/5.1, 6 environment

@ Note

O When not using IPX, it is recommended that you change the print server pro-
tocol in the Web browser from [TCP/IP+IPX] to [TCP/IP].

ﬂ Log on to the file server as an Admin or the equivalent of an Admin.
g Run SmartNetMonitor for Admin.

B Click [Property Sheet], and then click [OK].
The [NIB Setup Tool] dialog box appears.

ﬂ Click the [NetWare] tab, and make the following settings:
@ Select [File Server Mode] or [NDS Mode] as the Logon Mode.
@ In the [Print Server Name:] box, enter the name of the print server.

? Limitation

O Enter a maximum of 47 single-byte characters and numerals.

® In the [File Server Name:] box, enter the name of the file server in which a
print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

O In the [NDS Tree Name:] box, enter the name of the NDS tree.

Click [Browse] to display the NDS Tree list in the [Browse Context] dialog
box. If you double-click the NDS Tree selected from the list, its NDS Con-
text is displayed. Click the selected NDS Context to display it reversed,
then click [OK] and the name of the selected NDS Tree and NDS Context is
added to the [NDS Tree Name:] and [NDS Context Name:] dialog boxes.

? Limitation

O Enter a maximum of 32 characters, including hyphens and underscores.
@ In the [NDS Context:] box, enter the context of the print server.

& Note
O When selecting from the list in step@, the NDS Context is already added.
For context, object names are entered from a lower object and divided by a

period. For example, if you want to create a print server into Net under DS,
enter “NET.DS”:
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O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

B Exit SmartNetMonitor for Admin.
After this step, proceed to step [J on p.68 “Setting Up as a Print Server”.

Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or the equivalent of an Admin.
g Run the SmartNetMonitor for Admin.
B On the [Group] menu, point to [Search Device], and then click [IPX/SPX].

A list of printers appears.

& Note

O If you cannot identify which printer to configure from the list of printers,
print the configuration page and find it. For more information about print-
ing the configuration page, see “List/Test Print Menu” in the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating
Instructions” .

O If no printer name appears on the list, match the IPX/SPX frame types be-
tween the computer and printer. Use the [Network] dialog box of Windows
to change the computer frame type. For more information about changing
equipment frame types, see “Configuring the Printer for the Network” in the
Setup Guide.

ﬂ Select the printer you want to configure, and then click [NIB Setup Tool] on
the [Tools] menu.

B click [Property Sheet], and then click [OK].

E Click the [NetWare] tab, and make the following settings:
@ Select [File Server Mode] or [NDS Mode] as the Logon Mode.
@ In the [Print Server Name:] box, enter the name of the print server.

? Limitation

O Enter a maximum of 47 single-byte characters and numerals.

© In the [File Server Name:] box, enter the name of the file server in which a
print server is to be created.

By clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.
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O In the [NDS Tree Name:] box, enter the name of the NDS tree.

Click [Browse] to display the NDS Tree list in the [Browse Context] dialog
box. If you double-click the NDS Tree selected from the list, its NDS Con-
text is displayed. Click the selected NDS Context to display it reversed,
then click [OK] and the name of the selected NDS Tree and NDS Context is
added to the [NDS Tree Name:] and [NDS Context Name:] dialog boxes.

? Limitation

O Input using a maximum of 32 characters including hyphens and under-
scores.

@ In the [NDS Context:] box, enter the context of the print server.

& Note

O When selecting from the list in step@, the NDS Context is already add-
ed.

For context, object names are entered from a lower object and divided by a

B period. For example, if you want to create a print server into Net under DS,

enter “NET.DS”:

O In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, enter the number of the printer.

i@klmportant

O Use the same number as that of the printer to be created in the print
server.

@ Click [OK] to close the property sheet.
ﬂ On the [NIB] menu, click [Exit] to exit NIB Setup Tool.
B From Windows, run NWadmin.

A Reference
For more information about NWadmin, see the documentation provided

with NetWare.
ﬂ Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click [Print Queue], and then click [OK].
© In the [Print Queue name] box, enter the name of the print queue.
O In the [Print Queue Volume] box, click [Browse].

72



NetWare 4.x, 5/5.1, 6 - Advanced Settings

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After confirming the settings, click [Create].

[m Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
on the [Object] menu.

@ In the [Class of new object] box, click [Printer], and then click [OK]. When
you are using NetWare 5/5.1, 6, click [Printer (Non NPDS)].

© In the [Printer name] box, enter the name of the printer.
O Select the [Define additional properties] check box, and then click [Create].

ﬂ] Assign print queues to the created printer as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step ], and then
click [OK].

@ Click [Configuration], and in the [Printer type] list, click [Parallel], and then
click [Communication].

O Click [Manual load] in the [Communication type] group, and then click [OK].
@ After confirming the settings, click [OK].

m Create a print server as follows:

@ Select the context specified using NIB Setup Tool (Step [J - @), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click [Print Server], and then click [OK].
When you are using NetWare 5/5.1, 6, click [Print Server (Non NPDS)].

© In the [Print Server name] box, enter the name of the print server.

i@klmportant
O Use the same name as that specified using NIB Setup Tool. (Step @ - @).

O Select the [Define additional properties] check box, and then click [Create].

[B Assign the printer to the created print server as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step ffj, and then
click [OK].

© In the [Printers] group, click the printer assigned in step @, and then click
[Printer Number].

O Enter the printer number, and then click [OK].

ﬁlmportant
O Use the same number as that specified as Remote Printer No. using NIB

Setup Tool. (Step @ - @).
@ After confirming the settings, click [OK].
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m Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after closing.

< To exit
CAREE: unload pserver

% To start
CAREE: load pserver print server name



Setting Up a Client Computer

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

@ Note

O Use the version of Novell Client provided with your operating system or the
latest version.

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client.

After installing the printer driver, change the print port to NetWare queue.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

p Reference

For more information about installing the printer driver, see the Setup
Guide.

@ Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Add Port].

[ crick (Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
8 Click the queue you want to print, and then click [OK].

B click [0k,
In the [Print to the following port] box, a network path to the printer appears.
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[m Click [OK] to close the Printer Properties, and again, open it.
B Click the [Printer Settings] tab.
m Select to clear the [Form feed] and [Enable banner] check boxes.

& Note
O You should not select these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows 2000/XP/Server 2003, Windows NT 4.0

Follow the procedure to set up a Windows 2000/XP/Server 2003, Windows NT
4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.
The printers dialog box appears.
& Note

O When using Windows NT 4.0, the [Network Neighborhood] icon appears on
the desktop instead of the [My Network Places] icon.

B click Noj.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.
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B From the [Port] list, select the queue you selected in step f], and then click
[Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.

LENDPS
The machine operates using NDPS. Operating requirements are as follows:
e NetWare Version: 5.0, 5.1, 6

<« Printer Drivers and Operating Systems

Printer Driver (O5)

PCL Windows 95/98/Me
Windows 2000

Windows XP/Server 2003
Windows NT 4.0

PostScript 3 Windows 95/98
Windows NT 4.0

To use the machine with NDPS, NDPS Gateway is required.

* Novell NDPS Gateway

For more information about using Novell NDPS Gateway, see the manual
provided with it.

¢ Custom NDPS Gateway

For more information about using Custom NDPS Gateway, consult your au-
thorized retailer.

LFiPrint

This machine does not support iPrint.
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e
6. Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Basic Procedure

Change to EtherTalk J

(
( Configure the printer )
(

Change the printer name]

Change the zone

? Limitation

O The required version of Mac OS is 8.6 or later. (Mac OS X Classic environment
is supported.)

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

/O Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

Mac OS

ﬂ Open [Control Panel], and then double-click the [AppleTalk] icon.

ﬂ On the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name on the [Current zone:] pop-up menu.
O Ciose the [AppleTalk] dialog box.

B Restart the computer. 70
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Mac OS X

5] Preparation
You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

ﬂ Open [System Preference], and then click the [Network] icon.
B Click the [AppleTalk] tab.
B If you change zone, select a name on the [AppleTalk Zone:] pop-up menu.

ﬂ When the setting is complete, click [Apple Now].

Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

A Reference
For more information about configuration, see the Setup Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printerl” and “printer2”.

To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

/O Reference

For more information about using Printer Utility for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.
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Using SmartNetMonitor for Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of net-
work printers, but also allows you to change the configurations of the Network
Interface Board using the TCP/IP protocol or IPX/SPX protocol.

SmartNetMonitor for Admin is equipped with the following functions.

¢ Limits the settings to be done from the control panel, and disables changes to
be made to some of the items.

¢ Enables the selection of paper type loaded in the printer.

¢ Switches to the Energy Saver mode, and wakes up from the Energy Saver
mode.

® Checks the information on printing, paper exhaustion, and such, on the com-
puter.

* Monitors multiple printers at the same time. When there are many printers,
you can create groups and classify the printers to facilitate management.

¢ Checks the printer's network settings and detailed information of devices.
* Enables you to change the printer's network settings.
* Checks the number of pages printed for each computer, using the user codes.

Operating system Protocol stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me
IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows
95/98/Me

Novell Client for Windows 95/98/Me
Microsoft Windows 2000 TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT/2000/XP

Microsoft Windows XP/Server TCP/IP provided with Windows XP

2003 IPX/SPX provided with Windows XP
Novell Client for Windows NT/2000/XP
Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT
Client Service for NetWare provided with Windows NT
Novell Client for Windows NT/2000/XP

& Note
O Select the appropriate protocol stack for your operating system.
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? Limitation

O A TCP/IP environment is required when using the following functions:
¢ Using Tools
* Locking the Control Panel Menu
¢ Selecting the Paper Type
* Managing User Information
¢ Viewing and Deleting Spool Print Jobs
* Opening the Web browser using SmartNetMonitor for Admin

Changing the Network Interface Board Configuration

? Limitation

O Internet Explorer 4.01 or a later version is required to use NIB Setup Tool.
ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].
A list of printers appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer you want to change its configuration.

O £rom the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B Select [Wizard] or [Property Sheet], and then click [Next].

* When configuring the Network Interface Board for the first time, select
[Wizard].

* When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

@ Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

© A configuration list appears on the dialog box.
For more information about each item on the dialog box, see Help.
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Displaying Machine Status

You can view the status of machines
using SmartNetMonitor for Admin.

l] Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to
[Search Device], and then select
[TCP/IP] or [IPX/SPX].

The status of machines is indicated
by an icon in the list.

& Note
O For more information about sta-

tus icons, see SmartNetMonitor
for Admin Help.

B For further information, click the
desired machine from the list, and
then click [Open] on the [Device]
menu.

The status of the machine is dis-
played in the dialog box.

& Note

O For more information about
each item in the dialog box, see
SmartNetMonitor for Admin
Help.

Locking the Control Panel
Menu

n Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to
[Search Device], and then select
[TCP/IP] or [IPX/SPX].

A list of machines appears.

& Note

O Select the protocol of the ma-
chine for which you want to
change configuration.

B In the list, select the machine
whose numerical values you want
to manage.

ﬂ On the [Tools] menu, point to [De-
vice Settings], and then click [Lock
Operation Panel Menu].

A screen prompting you to enter a
password appears.

B Enter your user name and pass-
word, and then click [OK].

& Note

O To use the factory default ac-
count, enter no user name and
type “password” for the pass-
word.

Check the device status on the De-
vice Settings of the Web browser,
and change the device settings.

A Reference
For more information about
viewing status information and
changing settings using a Web
browser, see Device Settings
Help.
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Selecting the Paper Type

l] Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to
[Search Device], and then select
[TCP/IP] or [IPX/SPX].

A list of machines appears.

& Note

O Select the protocol of the ma-
chine for which you want to
change configuration.

B In the list, select the machine
whose numerical values you want
to manage.

ﬂ On the [Tools] menu, point to [De-
vice Settings], and then click [Select
Paper Type].

A screen prompting you to enter a
password appears.

B Enter your user name and pass-
word, and then click [OK].

& Note

O To use the factory default ac-
count, enter no user name and
type “password” for the pass-
word.

Check the device status on the De-
vice Settings of the Web browser,
and change the device settings.

p Reference

For more information about
viewing status information and
changing settings using a Web
browser, see Device Settings
Help.

Managing the User Information

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].
A list of printer appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer whose statistics information you want to manage.

ﬂ From the [Tools] menu, select [User Management Tool].

The screen that prompts you to type a password appears.
B Type the password, and then click [OK].

& Note
O The factory default password is "password".

The User Code Maintenance Tool starts up.

For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.
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Viewing and Deleting Spool
Print Jobs

l] Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to
[Search Device], and then select
[TCP/IP] or [IPX/SPX].

A list of machines appears.

& Note

O Select the protocol of the ma-
chine for which you want to
change configuration.

B In the list, select a machine whose
numerical values you want to
manage.

B on the [Tools] menu, click [Spool
Printing Job List (Printer)].

B Enter your user name and pass-
word, and then click [OK].

& Note

O To use the factory default ac-
count, enter no user name and
type “password” for the pass-
word.

Check Spool Print Job List on the
Web browser, and print out.

p Reference

For more information about
Spool Print Job List, see Spool
Print Job List Help.

& Note

O To display Spool Print Job List,
spool must be set to [Enable] on
Device Settings in advance.

Managing Address Information

n Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to
[Search Device], and then select
[TCP/IP] or [IPX/SPX].

A list of machines appears.

& Note

O Select the protocol of the ma-
chine for which you want to
change configuration.

B In the list, select a machine whose
statistics information you want to
manage.

B 0n the [Tools] menu, click [install
Printer Driver].

A screen prompting you to enter a
password appears.

BEnter the password, and then
click [OK].
& Note

O The factory default password is
“password”.

Install Printer Driver starts.

A Reference
For more information about In-
stall Printer Driver, see Install
Printer Driver Help.
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Configuring the Energy Save Mode

ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B Click [Group], point to [Energy Save Mode], and select any energy saver mode
from the menu that appears.
For more information about settings, see SmartNetMonitor for Admin Help.

& Note
O Point to [Set by Group] if you want to change all devices in the group.

O Point to [Set Individually] if you want to change only selected devices.
O In both cases, select the energy saver mode on the displayed menu.
O When you point to [Set Individually], [Timer Settings] is not displayed.



Configuring the Network Interface Board with a Web Browser

Configuring the Network Interface Board
with a Web Browser

You can check the status of a machine and change its settings using the Web
browser.

« Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

p Reference

For more information about configuring the machine to use the TCP/IP
protocol, see the Setup Guide.

< Operating system browser requirements

Operating system Browser
Windows 95/98/Me
- Microsoft Internet Explorer 5.5 or later
Windows 2000/ XP/Server 2003 .
Netscape Navigator 6.2 or later
Windows NT 4.0
Mac OS58.1~9.2.2 Netscape Navigator 6.2 or later
Mac OS X 10.1 or later Netscape Navigator 6.2 or later
4

« Limitation

O If the Web browser in use is older than the recommended version or [Java-
Script] and [Cookie] are not effective, display and operation problems may
occur.

O If you use a proxy server, change the Web browser settings. Consult your
network administrator about the settings.

O Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

O This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web browser when you want to reload this machine infor-
mation.

< Specifying the Address
Point the browser to the URL or IP address of the printer (e.g., ht-
tp:/ / XXX XXX XXX XXX/, where the Xs are the numbers in the IP address).
If the host name of the machine is registered on the DNS server or WINS serv-
er, you can enter it.
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Going to the Top Page

7 web Image Monitor - Microsoft Intemnet Explorer _[of %]
Fle Edt Yiew Favoitss Took Help ‘i
3 =g
) AT B
Back Foniar Stop  Refresh  Home Search  Faworites  History Mail Frint T
Aeliress [ &) it /7133133148, 10web user/en/websys/ webbsch/mainFrame cgi = f\>5|: || inks >

1 ——[RIGOE Aficio AP400

English = [ Top Page [ Adriristrator Mods EH;.lp Jure

Printer () Realy

2 ® Detail

display details

Y I

7P Status
> Iob YWEL IITdge IVIOTT
 Consigmtion ® Devics Name : RNPT4DFEC

® Conment

® Status

Paint ta sach fimetion with mouse pointez fo

€] Done

1. Header Area

You can register favorite URLs with
[URL]. To view the Help section, click
[HELP].

2. Menu Area

These Buttons are to configure the net-
work interface board and for checking
machine status.

3. Status

Displays the name and comments of the
network interface board, and machine
status.

4. Help
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Types of Menu Configuration and Mode

The items that appear on the menu area differ between user mode and adminis-
trator mode.

The work area which appears under the selected menu displays the status of the
machine under the user mode and the machine setting under the administrator
mode.

Menu User Mode At(:) Tﬁ:)s;rea
Status Input Tray O o
Output Tray O o
Toner O ©)
Function O ©)
System O O
Printer Language o @]
Job Printer Job History O o
Error Log O o
Locked & Sample Print o o
Configura- Paper — [
tion System — o
Printer O [
Notification — [
E-mail O [
Network Interface O [
Protocol Protocol O o
TCP/IP O L
NetWare O o
AppleTalk O [
SMB O L
SNMP — L
System Log O @]
Webpage O o
Security Password — o
Access Control — o
IPP Authentication — o
L4

e Limitation

O Documents stored under the copier and printer functions cannot be down-
loaded. 89
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@ Note

O O in the list indicates that machine status can be displayed.

O @ in the list indicates that machine settings can be changed.

p Reference

For more information about displaying status and changing settings, see p.91

“Using Help on the Web Browser”.

Verifying the Network
Interface Board Settings

Configuring the Network
Interface Board Settings

ﬂ Start the Web browser.

ﬂ Point your browser at the ma-
chine's URL or IP address (for ex-
ample, http://XXX.XXX.XXX. XXX,
where the Xs are the number of
the IP address).

The status of the machine you
chose appears on the Web brows-
er.

BClick the selected menu in the
menu area.

If a sub-menu appears, click it.

pe Reference
For more information about
each item, see p.91 “Using Help
on the Web Browser”.

ﬂ Start the Web browser.

ﬂ Point your browser at the ma-
chine's URL or IP address (for ex-
ample, http://XXX.XXX.XXX. XXX,
where the Xs are the number of
the IP address).

The status of the machine you
chose appears on the Web brows-
er.

B Click [Administrator Mode].

The dialog box for entering the
password and user name is dis-
played.

ﬂ Enter your user name and pass-
word, and then click [OK].

To use the factory default account,
enter no user name and enter
“password” for the password.

B Click the selected item in the
menu area and make the neces-
sary settings.

(3 click [Appiy1.
The configuration is transmitted.

A Reference
For more information about
making settings, see p.91 “Us-
ing Help on the Web Browser”.
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Using Help on the Web
Browser

When using Help for the first time,
clicking either [Help] in the header
area or the icon marked "?" in the
work area makes the following screen
appear. From there you can check
Help in two different ways, as shown
below:

< Checking a Help Using the Internet
You can check the latest Help up-
dates.

< Downloading and Checking Help
You can download Help from the
Internet.

& Note

O By clicking [Help] in the header ar-
ea, Help contents normally ap-
pears.

O By clicking "?", the Help icon in the
work area, Help for the items
shown in the work area normally
appears.

Downloading Help

ﬂ Select the operating system in the
[0S:] list.

ﬂSelect the language in the [Lan-
guage] list.

B ciick [pownload).

ﬂ Download Help by following the
messages on screen.

B Save the downloaded compressed
file and decompress it.

@ Note

O To check the downloaded Help,
specify the path where the doc-
ument is decompressed.

’3'Qf=Linking the address (URL) to
the [Help] button

You can link the address (URL) of the
[Help] button to the Help files on the
computer or Web server.

® Download the Help files on the
machine to the desired location.

® Using a Web browser, navigate to
Top Page and click [Administrator
Mode].

® Click [Configration], and then click
[Webpage].

@ Enter your password, (it is not nec-
essary to enter a user name) and

click [OK].

® Enter the path to the Help files in
the [Help URL] box.
If you copied the Help files to
“C:\HELP\EN?"”, enter “file
://C:/HELP/”. For example, if
you copied the files to a Web serv-
er and the index URL is “http://
a.b.c.d/HELP/EN/index.html”,
enter “http://a.b.c.d/HELP/”.

® Click [Apply].
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to easily iden-
tify the printers listed on SmartNetMonitor for Client.

The following utilities are used to change printer names and comments.

< SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartNetMonitor for Admin
from the CD-ROM that comes with the printer. For more information about
installing SmartNetMonitor for Admin, see the Setup Guide.

< Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

& Note

O Each of the names, in a TCP/IP protocol form (printer name) and in a Net-
BEUI protocol form, is changed individually. Comments are, however,
common to both of them.

O The factory default name consists of "RNP" and the last 3 bytes of the MAC
address on the Network Interface Board. For example, when the MAC ad-
dress is 00:00:74:62:7D:D5, the factory default name is "RNP627DD5".
Comments are not configured.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

gClick the [Group] menu, point to [Search Device], and select [TCP/IP] or
[IPX/SPX]. A list of printers appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer whose Network Interface Board you want to
change its configuration.

ﬂ From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.



Monitoring and Configuring the Printer

B seiect [Property Sheet], and then click [OK].

TCP/IP

@ Click the [General] tab, and then type the device name into the [Device
Name] box and comment into the [Comment] box.

* In the [Device Name] box, type the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

¢ In the [Comment] box, type any comment on printers in under 31 charac-
ters.

NetBEUI

@ Click the [General] tab, and then type the comment into the [Comment]
box.

In the [Comment] box, type any comment on printers in under 31 characters.
@ Click the [NetBEUI] tab.
© Type the computer name into the [Computer Name] box.

* In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/5<=>?[\]l. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

* In the [Comment] box, type any comment on printers in under 31 charac-
ters.

A ciick [ox.
The NIB Setup Tool exits, and the setting is transmitted to the printer.

ﬂ Exit SmartNetMonitor for Admin.
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Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer you want to change the
settings)"".
The status of the selected printer is displayed on the Web browser.

B Click [Configuration].

A dialog box that prompts you to type the user name and a password ap-
pears.

ﬂ Type the user name and the password, and then click [OK].

Type only the password in this dialog box. The factory default password is
"password".

B Change names and comments.

TCP/IP

@ Click [General], and then type the name into the [Device Name:] box and
comment into the [Comment] box.

* In the [Device Name:] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to in under 13 characters.

* In the [Comment] box, type any comment on printers in under 31 charac-
ters.

@ Click the [IEEE 1394], and then type the name into the [Device Name:] box
when you change the device name for IEEE 1394 (IP over 1394) interface.

¢ In the [Device Name:] box, enter the name of the printer in under13 char-
acters. The factory default name consists of "RNP" and the last 5 bytes
of the EUI-64 on the IEEE 1394 (IP over 1394) Interface. For example,
when the EUI-64 is 00:00:74:00:02:01:0A:66, the factory default name is
"RNP0002010A66". No name of 13 characters is permitted if the prefix is
"RNP".
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NetBEUI

@ Click [NetBEUI].

@ Type the name into the [Computer Name] box and comment into the [Com-
ment] box.

* In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/5<=>?[\]Il. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

* In the [Comment] box, type any comment on printers in under 31 charac-
ters.

A click [Appiy].
The setting is transmitted to the printer.

ﬂ Exit the Web browser.

Displaying the Status of Printer

You can view the status of printers using SmartNetMonitor for Admin, Smart-
NetMonitor for Client, or Web browser.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

The status of printers is indicated with an icon in the list.

& Note

O For more information about the status icons, see SmartNetMonitor for Ad-
min Help.

B Getting further information, click the desired printer to select from the list,
and then click [Open] on the [Device] menu.

The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.
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SmartNetMonitor for Client

Viewing the status of printers using SmartNetMonitor for Client, you must, in
advance, configure SmartNetMonitor for Client so it monitors the printer whose
status you want to view.

Monitoring Printers

ﬂ Run SmartNetMonitor for Client.
The SmartNetMonitor for Client icon appears at the right end of the taskbar.
g Right-click the SmartNetMonitor for Client icon, and check if the desired
printer is configured on the pop-up menu that appears.
If it is configured, see SmartNetMonitor for Client Help.

B If the desired printer is not configured, click [Options] on the pop-up menu.
The [SmartNetMonitor for Client - Options] dialog box appears.

ﬂ Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

& Note
O Selecting the [Displayed on Task Bar] check box will bring up the status of a

printer with an icon on the SmartNetMonitor for Client icon on the task
tray.
B ciick [0k
The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

ﬂ Run SmartNetMonitor for Client.

g The status of printers is displayed on the SmartNetMonitor for Client icon
on the task tray.

& Note

O For more information about the status icons, see SmartNetMonitor for Cli-
ent Help.

B Getting further information on the status, right-click the SmartNetMonitor
for Client icon, and then click the desired printer.

The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.
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Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer whose status you want
to view)".

The status of the selected printer is displayed on the Web browser.
B Click [Status] and you can check the status of the printer.

& Note
O For more information about each item, see Help.
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Using the IEEE 802.11b (Wireless LAN)

5] Preparation
Make sure to configure the IP address and Subnet mask of this machine. To
make settings from the control panel of this machine, see the Setup Guide.

Use the WiFi authorized card for an access point and the IEEE 802.11b card in
the computer.

Setting IEEE 802.11b (Wireless LAN)

m |[EEE 802.11b (wireless LAN) setup procedure

( A

‘ <When the Ethernet Board is installed> ’
Select [IEEE 802.11b] on [Interface Settings]

||
( Select the communication mode ]

(ad hoc mode ) (802.11 ad hoc mode] ( infrastructure mode )

o ||
(Set the Channel ) Set the SSID )

<When setting the code>

C Set the WEP key )
o
C Enable/Disable the code )
- - -
( Apply the settings )
( Confirm the connection )

v J

& Note

O When using Windows XP/Server 2003 standard Driver or Utilities to com-
municate with Windows XP/Server 2003 wireless LAN clients, select “802.11
Ad hoc mode”.
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Using in Infrastructure Mode

Infrastructure mode is for transmitting data to the network via an access point.

The infrastructure mode settings can be made on the machine control panel;
however, they can also be made from telnet or a web browser.

p Reference

For more information about how to make settings from the control panel of
the printer, see the General Settings Guide.

For more information about how to use telnet and a Web browser, see p.87
“Configuring the Network Interface Board with a Web Browser” or p.102
“Remote Maintenance by telnet”.

ﬂlmportant

O If you cannot connect after making SSID and WEP key settings, press [System
Settings] then [Interface Settings] then [IEEE 802.11b], and then [Return to Defaults]
to return to the default settings.

O With some products, depending on the access point or IEEE 802.11b card in
use, it is possible to set more than one WEP key. In this case, make the first
key the same as the WEP key set in the printer.

Using in Ad hoc Mode

Ad hoc mode is for transmitting data between wireless LAN clients without us-
ing an access point. Depending on the client's operating environment, make sure
to select “802.11 Ad hoc mode” which need a SSID or “Ad hoc mode” which
does not need a SSID. The ad hoc mode settings can be made on the machine
control panel; however, they can also be made from telnet or a web browser.

/O Reference

For more information about how to make settings from the control panel of
the machine, see the Setup Guide.

For more information about how to use telnet and a Web browser, see p.87
“Configuring the Network Interface Board with a Web Browser” or p.102
“Remote Maintenance by telnet”.

For more information about how to make setting for the IEEE 802.11b card in-
stalled in the computer and the computer in use, see the appropriate operat-
ing instructions or consult your network administrator.

& Note

O Depending on the client software of the IEEE 802.11b card installed in the
computer, the channels might not be able to be set. In this case, set the printer
channel to the channel specified by the computer.

O When there are multiple ad hoc mode clients using different communication
modes, communications may not work correctly.
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Confirming the Connection

nMake sure the LED of the IEEE
802.11b card is lit.

< When using in Infrastracture Mode

e Tam
-

|Lf
N

ZGDH600J

1. If the IEEE 802.11b card is work-
ing, it is lit in orange. If the IEEE
802.11b (wireless LAN) is not select-
ed, it does not light, even if the print-
er power is on.

2. If it is connected properly to a net-
work, the LED is green in infrastruc-
ture mode. When the LED is
blinking, the machine is searching
for devices.

< When using in Ad hoc Mode/802.11
Ad hoc Mode

e Tam
-

|Lf
N

ZGDH600J

1. If the IEEE 802.11b card is work-
ing, it is lit in orange.
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2. If itis connected properly to a net-
work, the LED is green in ad hoc
mode or 802.11 ad hoc mode. When
the LED is blinking, the machine is
searching for devices. The LED will
light after a few seconds.

ﬂ Use a Web Browser to check the
printer is connected properly. See
p-87 “Configuring the Network
Interface Board with a Web
Browser”.

BPrint the configuration page to
verify settings.

For more information about how
to print the configuration page, see
the Printer Reference.

Infrastracture Mode

You can check the machine's radio
wave status using the machine's con-
trol panel.

ﬂ Press the [Menu] key.
“Menu” appears on the panel dis-
play.

ﬂ Press [V] or [A] to display the
“Maintenance” menu.

B Press [ Enter #].
The following message appears on

the panel display.

ﬂ4 Press [V] or [A] to display
"WL.LAN Signal".
B Press [Enter #].

One of the following messages ap-
pears on the panel display.

The machine's radio wave status is
displayed.
E Press [Escape].

“Ready” appears on the panel dis-
play.
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When Moving the Machine

When moving the machine with the antennas attached, keep the following
points in mind.

Detach the antennas when relocating the machine.
After moving the machine, reattach the antennas, ensuring that:
* the antennas are positioned away from obstacles.

¢ there is 40 to 60 mm between the antennas, so they do not touch.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

& Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote mainte-
nance.

Using telnet

The following is a sample procedure using telnet.

? Limitation

O Only one person at a time can be logged on to do remote maintenance.
ﬂ Using the IP address or host name of the machine, start telnet.
% telnet IP address

& Note

O In order to use the host name instead of the IP address, you must write it
to the hosts file.

g Type the password.

& Note
O The default is “password”.

B Type a command.

/O Reference
For more information about telnet commands, see p.103 “Commands

List”.
ﬂ Exit telnet.
msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.
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B Type “yes” to save the changes, and then press the [ENTER] key.

If you do not want to save the changes, type “no”, and then press the [ENTER)
key. If you want to make additional changes, type “return” at the command
line, and then press the [ENTER] key.

@ Note

O If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.

O The Network Interface Board is reset automatically when the settings are

changed.

O When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

Use this command to display remote maintenance use.

@ Note

O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that

command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP/IP (IP address, subnet mask, broad-

cast address, default gateway address) for the machine.

«» Reference
msh> ifconfig

< Configuration

msh> ifconfig interface name parameter address

Interface name Interface to be configured
ether Ethernet Interface !

nc0

ip1394 2 IEEE 1394 Interface

fwip0 2

wlan "3 IEEE 802.11b Interface
wi0
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1 If you did not enter the interface name, it will be automatically set to the Ethernet
interface.
"2 Available when the 1394 Interface Unit Type 4510 is installed.

" You can specify an interface when installing the optional 802.11b Interface Unit

Type A.
Parameter Meaning
(no parameter) IP address
netmask subnet mask
broadcast broadcast address

< Changing the Interface
You can specify either the LAN interface or IEEE 802.11b interface when us-
ing the optional 802.11b Interface Unit.

msh> ifconfig interface up

& Note
O You cannot specify the optional IEEE 1394 Interface Unit Type 4510.

The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

@ Note

O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O The TCP/IP setting is the same as that for the LAN interface and IEEE 802.11b
interface.

O To type an address using hexadecimal, prefix it by “0x”.

’iQ'FAddress

% Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

& Note
O To get the above addresses, contact your network administrator.

O The subnet mask is the same as that for the LAN interface and IEEE 802.11b
interface.

O When installing the optional 1394 Interface Unit Type 4510, set the subnet so
that it does not overlap with the LAN interface or the 1394 interface.
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Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

+% Reference

msh> access

< Configuration
msh> access W range start-address end-address
* 3 represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)
Example: To specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

& Note

O The access range restricts the workstations from which printing is possible
by means of an address. If you do not need to restrict printing, make the
setting “0.0.0.0”.

O The entry is invalid if the start address is greater than the end address.

O Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

O When using a Web browser, telnet or SmartNetMonitor for Client/ Admin,
you can use an IP address that has not been restricted by access control.

< Access Control Initialization
msh> access flush

& Note

O This restores the factory-default settings so that all access ranges become
"0.0.0.0".
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

Protocol

appletalk

tepip
netware

“up” means active and “down” means
inactive.

netbeui
smb
scsiprint ™!
ip1394 1
lpr

ftp

rsh
diprint
web

snmp

ipp

"1 Available when the 1394 Interface Unit Type 4510 is installed.

& Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using
ip1394, lpr, ftp, rsh, diprint, web, snmp and ipp.

DHCP

Use the "dhcp" command to configure the DHCP settings.

% Reference
The following command displays the current DHCP settings.
msh> dhcp

< Configuration
You can configure the DHCP settings.
msh> dhcp interface name {on|off}

& Note
3 Select [on] to enable DHCP. Select [off] to disable DHCP.
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« Interface Priority Configuration
You can assign priorities governing which interface obtains DHCP parame-
ters.

msh> dhcp priority interface name

& Note
O Priority assignment is useful when connecting more than one interface to the
machine.

O If an interface is not selected, it appears according to the currently set priority
regardless of multiple interface connections.

Interface name Interface to be configured
ether Ethernet interface

wlan " IEEE 802.11b interface
ip1394 2 IEEE 1394 interface

"I Available when the optional 802.11b interface Unit is installed.
"2 Available when the optional 1394 interface Unit is installed.

A Reference
For more information about DHCP, see p.139 “Using DHCP”.

Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Command Information that is displayed

status Status of printer.
Information about the print jobs.

info Information about the paper tray, output tray,
printer language of printer.
prnlog [ID] Lists the last 16 print jobs.
& Note

O More information about any print job is displayed when the ID number is
added after the prnlog command.

p Reference

For more information about the meaning of the data returned with these com-
mands, see p.126 “Configuring the Network Interface Board”.
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-pl]

@ Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

p Reference

For more information about the meaning of the data returned with this com-
mand, see p.126 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system log.

msh> syslog

/O Reference

For more information about the displayed information, see p.130 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

& Note
O The 1394 interface board supports TCP/IP only.

O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only read-write
trap off trap off
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9
%

9
%

Display

Shows the SNMP information and available protocols.
msh> snmp ?

msh> snmp [-pl [registered numberl]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.

Community name configuration
You can set the community name of the registered number.

msh> snmp number name community name

& Note
O The community name must consist of 15 characters or less.

Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol

will be disabled:
msh> snmp {ip | ipx} {on | off}

* “on” means active and “off” means inactive.

To change the protocol of an access setting use the following command. How-
ever, if you disabled a protocol with the above command, making it active
here will have no effect.

msh> snmp number active {ip | ipx} {on | off}
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< Access configuration

You can configure the address of a host depending on protocols used.

The network interface board accepts requests only from hosts with addresses
“read-only” or “read-write” access type. Enter “0” to have the network inter-
face board accept requests from any host without requiring a specific type of
access.

msh> snmp number {ip | ipx} address

& Note

O To specify TCP/IP protocol, enter ip followed by a space, and then the IP
address.

O To specify the IPX/SPX protocol, enter ipx followed by a space, and then
the IPX address followed by a decimal, and then the MAC address of the
network interface board.

The following is an example of how to configure registration number 3 with

the IP address 192.168.15.16:

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with

the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65:

msh> snmp 3 ipx 7390A448:000074625C65

IPP

Use the ipp command to configure the IPP settings.

< Viewing setting

The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900 (sec)
auth basic

¢ The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

¢ The “auth” setting indicates the user authorization mode.

< IPP timeout configuration

Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh> ipp timeout {30 - 65535}
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< IPP user authorization configuration

Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .

ipp auth {basic|digest|off}
¢ “basic” and “digest” are user authorization setting.
e “off” removes the user's authorization.

& Note

O If you select “basic” or “digest”, see next section “Entry the IPP User Au-
thorization” for how to configure the user name. Up to ten user names are
available.

% Configuring the IPP user authorization
Use the following command:

L)

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:userl
IPP password:****xk%*
After configuring the settings, the following message appears.

User configuration changed.

SPRINT

To make setting for IEEE 1394 (SCSI print), use the “sprint” command.

< View settings
The IEEE 1394 (SCSI print) settings are displayed.

msh> sprint

< Bidirectional configuration for the IEEE 1394 (SCSI print)
Use this setting to set the IEEE 1394 (SCSI print) to bidirectional.
The factory default is “on”.

msh> sprint bidi [on/off]
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Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.

Use the diprint command to change the direct printing port settings.

2
**

9
%

112

View settings
The following command displays the current direct printing port settings.

msh> diprint
Example output:

port 9100
timeout=300 (sec)
bidirect off

* The “Port” specifies the port number of the direct printing port.

¢ The “bidirect” setting indicates whether the direct printing port is bidirec-
tional.

Setting timeout
You can specify the timeout interval to use when receiving data from the net-
work.

msh> diprint [0~65535]

& Note
O The factory default is 300 seconds.

O If 0 is set, timeout is disabled.

Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.

msh> diprint bidirect {on|off}

@ Note

O If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on
Windows 2000 might not work correctly.
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SMB

Use the “smb” command to configure or delete the computer name, workgroup
name, or comment.

msh> smb parameter

Parameter Settings

comp Your computer name consisting of up to 15 characters
group Workgroup name consisting of up to 15 characters
comment Comment consisting of up to 31 characters

clear comp Clears the computer name

clear group Clears the Workgroup name

clear comment Clears comment

9
%

Protocol Configuration
Use the following command to (in) activate the protocols.

msh> smb protocol protocol name {up|down}

Protocol name

netbeui “up” means active and “down” means inactive

tepip

web

Use the “web” command to display and configure the parameters on the Web
browser.

2
**

2
%

View Settings

msh> web

URL Configuration
The link address reached by pressing [URL] on the Web browser can be set.

web url The URL or IP address you want to register.
Example:
(Xs represent the IP address.)

msh> web url http://XXX.XXX.XXX.XXX/

Link Name Configuration
You can enter the name for [URL] that appears on the Web browser.

msh> web name Name you want to display
Example:
(Xs represent the name you want to display.)

msh> web name XXX
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< Help URL Configuration
The link address reached by pressing [Help] or “?” on the Web browser can be
set.
msh>web help Help URL or IP address
Example:
(Xs represent the IP address.)

msh> web url http://XXX.XXX.XXX.XXX/help/

ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

& Note

O The maximum number of routing tables are 16.
Commands Topics of setting
route add {host | net} desti- | Adds a host/network route to “destination”, and a gateway ad-
nation ! gateway ! dress to “gateway” in the table. Host becomes the default setting.
route delete {host | net} Deletes a host/network route from the table. Host becomes the
destination " default setting.
route get {destination " } Displays only route information corresponding to a specified

destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des- | You can turn the specified destination on or off. Host becomes
tination "' on/off the default setting.

route add default gateway | You can set the default gateway address.
1

route flush Deletes all routing information.

L TP address

SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PurelP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

@ Note

O The default value of TTL is “1”. A search is executed only within a local seg-
ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

O The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}
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Setting IEEE 802.11b

To make setting for IEEE 802.11b, use the wiconfig command.

? Limitation

O You can make settings when installing the optional 802.11b Interface Unit.

< View settings

The IEEE 802.11b settings are displayed.

msh> wiconfig

The IEEE 802.11b card information is displayed.

msh> wiconfig cardinfo

& Note

O If the IEEE 802.11b interface is not working correctly, the IEEE 802.11b card

information is not displayed.

< Configuration

Parameter

Value to be configured

mode [ap | adhoc|802.11adhoc]

You can set infrastructure mode (ap), 802.11
ad hoc mode (802.11adhoc) or ad hoc mode
(adhoc).

The default is ad hoc mode.

ssid ID value

You can set for SSID in infrastructure mode.

The characters that can be used are ASCII
0x20-0x7e (32 bytes).

A SSID value is set automatically to the near-
est access point if the setting has not been
made.

If the setting has not been made for ad hoc
mode, the same value as for infrastructure
mode or an "ASSID" value is set automatical-
ly if the setting has not been made.

channel frequency channel no.

You can set the channel.

You can specify from following channel.
® Metric Version :1-13

e Inch Version :1-11

Set the same channel for all the machines you
are using.

enc [on | off]

You can enable or disable the WEP function.
To enable the WEP function, specify [on]; to
disable it, specify [off].

To start the WEP function, enter the correct
WEDP key.
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Parameter Value to be configured

key [key value] With 64-bit WEP, you can use 10 digit hexa-
decimal. With 128-bit WEP, you can use 26
digit hexadecimal.

To use this function, set the same WEP key
for all ports that transmit to each other.

auth [open | shared] You can set the authorized mode when using
WEP. The specified value and the authorized
mode are as follows:

open: Open system authorized (default)
shared: Shared key authorized

rate [auto | 11m | 5.5m | 2m | 1m] You can set the IEEE 802.11b transmitting
speed.

The transmitting speed you specify here is
the speed at which data is sent. You can re-
ceive data at any speed.

auto: automatically set (default)
11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Job Spool

Use this command to configure Job Spool settings.

? Limitation

O You can only specify the LPR and IPP protocol.

% Reference
The job spool setting appears.

msh> spoolsw

< Job Spool Setting

msh> spoolsw spool {on | off}

& Note
O Specify "on" to enable the job spool function or "off" to disable it.

< Protocol Configuration
To change the protocol settings, use the following command. You can specify
the setting for [lpr] or [ipp].

e lpr

msh> spoolsw lpr {on | off}
* ipp

msh> spoolsw ipp {on | off}
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e smb
msh> spoolsw smb {on |off}

Changing the Host Name

Use the hostname command to change the printer name.

msh> hostname [interface name ] printer name

interface name Interface to be configured
ether Ethernet interface ™

wlan "2 IEEE 802.11b interface
ip1394 " IEEE 1394 interface

I If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.

"2 If you install the 802.11b Interface Unit Type A, you can set the command.

3 If you install the 1394 Interface Unit Type 4510, you can set the command.

& Note

O Enter the printer name using up to 13 characters.
O You cannot use a printer name starting with RNP or rnp.

O The Ethernet interface and IEEE 802.11b interface will have the same printer
name.

WINS

Use the wins command to configure the WINS server settings

For more information about WINS server settings, see p.141 “Configuring a
WINS Server”.

< Viewing setting
The following command displays the WINS server IP address.

msh> wins
Example out put:

wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:

primary server 192.168.10.1 secondary server
192.168.10.2

hostname RNP620B47 ScopelD

& Note

O If DHCP is used to start from the network, the current WINS server ad-
dress is displayed. This address, however, is not displayed if DHCP is not
used.

O If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.
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< Configuration
Use the set command to make WINS active or inactive.

msh> set wins {on|off}

¢ "on" means active and "off" means inactive.
< Address configuration
Use this command to configure a WINS server IP address.

msh> wins {primary|secondary} IP address

& Note
O Use the "primary" to configure a primary WINS server IP address.

O Use the "secondary" to configure a secondary WINS server IP address.

AutoNet

Use the "autonet" command to configure AutoNet settings.
< Display
The following command displays the current AutoNet settings.

msh> autonet

< Configuration
You can configure the AutoNet settings.

msh> autonet interface name {on|off}

& Note
O Select [on] to enable AutoNet.

3 Select [off] to disable AutoNet.

« Interface Priority Configuration
You can assign priorities governing which interface obtains AutoNet param-
eters.

msh> autonet priority interface name

& Note

O Priority assignment is useful when connecting more than one interface to
the machine.

O If an interface is not selected, the interface appears according to the cur-
rently set priority, regardless of multiple interface connections.

Interface name Interface to be configured
ether Ethernet interface

wlan IEEE 802.11b interface
ip1394 2 IEEE 1394 interface

"1 Available when the optional 802.11b interface kit is installed.
"2 Available when the optional 1394 interface board is installed.
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p Reference
For more information about AutoNet, see p.140 “Using AutoNet”.

SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

? Limitation

O SNTP supports the NTP servers running xnptd V3 and V4.

< Reference
msh> sntp

< NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP address

< Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling time

& Note
O The factory default setting is 3600 seconds.

O You can set the interval from 16 to 16384 seconds.

O If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

< Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.

msh> sntp timezone +/-hour time
Example: To set the time-zone difference to +8 hours:

msh> sntp timezone +08:00

& Note
O The time is in 24-hour notation.

119



120

Appendix

Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.
0l1ld password:

B Type the new password.

New password:

& Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:

DNS

Use the "dns" command to configure or display DNS (Domain Name System)
settings.

< View setting
The following command displays current DNS settings:

msh> dns

< Using the DNS server obtained from the DHCP server
The following command enables/disables use the DNS server obtained from
the DHCP server:
msh> dns dhcp {valid | invalid}
 If you use the DNS server obtained from the DHCP server, select “valid”.

If not, select “invalid”.
If you set “valid”, the DNS server from the DHCP server is prioritized.
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« DNS server configuration
The following command enables/disables use of the DNS server address:

msh> dns number server / server address
The following is a sample configuration using an IP address of 192.168.15.16
on DNS 1 server:

msh> dns 1 server 192.168.15.16
* You can register up to three DNS server numbers.
* You cannot use “255.255.255.255” as the DNS server address.

Domain name

Use the "domainname" command to display or configure domain name settings.

You can configure the Ethernet interface, IEEE 1394 interface, or IEEE 802.11b in-
terface.

< View setting
The following command displays the current domain name:

msh> domainname

< Interface domain configuration
The following command displays or sets the Ethernet interface domain name,
IEEE 1394 interface, or IEEE 802.11b interface.

msh> domainname / interface name
The following is a sample configuration using a domain name on the Ethernet
interface:

msh> domainname ether

Interface Interface that can be set
ether Ethernet interface
ip1394 ™ IEEE 1394 interface
wlan 2 IEEE 802.11b interface

" Available when the optional 1394 interface board is installed.
"2 Available when the optional 802.11b interface kit is installed.

& Note
O A domain name can consist of up to 63 alphanumeric characters.
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1} Setting Protocols

The protocols described in this section provide various functions that can be
used on the machine.

ﬂlmportant

O If a protocol is disabled or inactive, functions provided by that protocol can-
not be used.

p Reference

For more information about setting protocols, consult your network adminis-
trator.

< LPR
¢ Printer function using Standard TCP/IP
¢ Printer function using command line

< RSH/RCP

* Printer function using command line
* Scanner function using the network TWAIN driver

* Function to obtain device information by command line

« DIPRINT

* Printer function using SmartNetMonitor for Client
< FTP

¢ Printer function using command line

¢ Scanner function using a delivery server
* Function to obtain device information by command line

< IPP
* Printer function using SmartNetMonitor for Client
< NetWare

¢ Printer function using NetWare server (remote printer/printer server)

& Note

O If protocols are disabled or inactive under PurelP environment, only the
print server can be used.
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< AppleTalk
¢ Printer function using Appletalk with Macintosh

& Note
O This function can be selected when a module supporting PostScript 3 is at-

tached.
< SMB
* Printer function using SmartNetMonitor for Client
* Printer function using Microsoft Windows Network

< SNMP
* Bidirectional configuration for the printer driver

* Function to obtain device information by SmartNetMonitor for Ad-
min/Client
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

/O Reference

You can configure SNMP from the command line using telnet. See p.108
“SNMP”.

You can configure SNMP from SmartNetMonitor for Admin using the NIB
Setup Tool. See Help for SmartNetMonitor for Admin.

You can configure SNMP from your Web browser. See Help on the CD-ROM.

? Limitation

O The kinds of supported MIBs vary depending on the printer.

< Supported MIBs
e MIB-II
® PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
¢ telnet: Use the status command. See p.107 “Printer status” .

Item name Meaning
Rank Print job status.
e Active
Printing or preparing for printing.
¢ Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).

The default is “0 bytes”.

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
¢ telnet: Use the prnlog command. See p.107 “Printer status” .

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received
UserID ™ User ID that is to be configured in the printer driver.
JobName The name of the document for printing.

"I Appears the UserID and JobName information when entering the info command
with the ID.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.

¢ telnet : Use the show command. See p.108 “Network Interface Board config-
uration settings information” .

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk

TCP/IP

NetWare

NetBEUI

smb

IP over 1394 ™1

SCSI print
Ethernet interface Internal version number.
Syslog priority
NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk
Mode AppleTalk protocol in selection.

Net Network number.

Object Macintosh printer name.

Type The type of printer.

Zone Name of the zone that the printer belongs to.
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Access Range[>] 2

Time server

Item name Meaning
TCP/1P
Mode Up means active, Down means inactive.
ftp
lpr
rsh
diprint
web
http
ftpc
telnet
snmp
ipp Frame type.
autonet IP address.
EncapType Subnet mask.
Address Broadcast address.
Netmask Default gateway address.
Broadcast Access Control Range.
Gateway NTP server address

NTP server time difference

Synchronizes interval

Time Zone URL of homepage.
Time server polling time URL name of homepage.
Syslog server URL of help page.
Home page URL Protocol used with SNMP.
Home page link name
Help page URL
SNMP protocol
NetWare
EncapType Frame type.
RPRINTER number Remote printer number.

Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation
Login Mode
Print job timeout

Print server name.
Name of the connect file server.

Context of print server.

Active mode.

(this value is fixed)

Select File Server Mode or NDS Mode as the Logon
Mode.

Time of the job timeout.
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Item name

Meaning

Protocol

SAP internal time

For the protocol used for communication with the print
server, select from TCP /IP+IPX, IPX, and TCP/IP.

Workgroup name
Computer name
Comment

Share name[1]

NDS Tree Name The SAP sending interval for service notification from
the device side.
The name of the connected NDS Tree.
SMB
Switch
Mode (this value is fixed)
Direct Print (this value is fixed)
Notification Notification of print job completion.

Name of the workgroup.
Name of the computer.
Comment.

Share name (name of the printer type).

ip1394 "

Protocol
NetBEUI TCP/IP
IEEE 802.11b " SSID being used.
SSID Channels available for use.
Channel range Channel being used.
Channel IEEE 802.11b interface transmitting mode.
Communication mode IEEE 802.11b interface speed.
Rate Whether WEP is enabled or disabled.
WEP encryption Validity or invalidity of the authorized mode setting
Auth when using WEP.
Encryption key WEP key.
IP over 1394 ™
Device name
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
SCSI print ™
Bidi. Bidirectional setting (on/ off).
Shell mode Mode of the remote maintenance tool.
Domain name
ether Ethernet interface domain name
wlan IEEE 802.11b interface domain name

IEEE 1394 interface domain name
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Item name Meaning
WINS
ether Ethernet interface WINS name
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
ip 1394 ™ IEEE 1394 interface WINS name
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
wlan IEEE 802.11b interface WINS name
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
Shell mode Mode of the remote maintenance tool

"I The 1394 Interface Unit Type 4510 supports TCP/IP only.

2
3

Type A.
*4

Type 4510.
*5

v represents a target number between 1 and 5.
You can display the item names when installing the optional 802.11b Interface Unit

You can display the item names when installing the optional 1394 Interface Unit

Y7 represents a target number between 1 and 3.
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Message List

This is a list of messages written to the machine's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ telnet: Use the syslog command. See p.108 “System log information” .

Message

Description and Solutions

Access to NetWare server <file servername>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In print server mode) Cannot log in to the file
server. Make sure that the print server is regis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists.
Use another community name.

add_sess: session<community name>already
defined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>,
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_ipx:session_ipx<community name>
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk)

An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name>

Attached to the file server as a nearest server.

Attach to print queue <print queue name>

(In print server mode) Attached to the print
queue name.

Cannot create service connection

(In remote printer mode) Cannot establish a
connection with the file server. The number of
file server users may exceed the maximum
number that the file server can handle.
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Message

Description and Solutions

Cannot find rprinter (<print server
name>/<printer number>)

The printer having the number displayed on
the print server does not exist. Make sure that
the number of the printer is registered in the
print server.

Change IP address from DHCP Server.

The IP address changes when DHCP LEASE is
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

child process exec error! (process name)

Failed to start the network service. Turn the
printer off and then on. If this does not work,
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from
the DHCP server.

connection from <IP address>

Logged on from the host <IP address>.

Could not attach to FileServer<error number>

(In remote printer mode) Cannot attach to the
file server. For some reason, the file server
refuses the connection. Check the file server
configuration.

Could not attach to PServer<print server>

(In remote printer mode) Cannot attach to the
print server. For some reason, the print server
refuses the connection. Check the print server
configuration.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mb-
ps).

Current IP address <current IP address>

The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address>

The current IPX address.

DHCP lease time expired. DHCEP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure
the DHCP server is running on the network.

dhcped start. A dhcpced (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,
(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with
the print server has been established.

exiting

Ipd service has ended and the system is exiting

the process.
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Message

Description and Solutions

Exit pserver

(In print server mode) Exits the print server
because the necessary print server settings
have not been made.

failed to connect smtp server.

Failed to connect the SMTP server. This could
be because:

¢ There is no connection to the network.

* The network configuration is incorrect, so
there is no response from the SMTP server.

e The SMTP server name is incorrect.
* The specified SMTP server is incorrect.

* There is no specified SMTP server IP ad-
dress in the DNS server.

¢ Another server other than the SMTP server
has been specified.

* The SMTP server port number is incorrect.

failed to connect smtp server. timeout.

Failed to connect the SMTP server due to time-
out. This could be because:

e The SMTP server name is incorrect.
¢ There is no connection to the network.

¢ The network configuration is incorrect, so
there is no response from the SMTP server.

failed to get smtp server ip-address.

Failed to get the SMTP server IP address. This
could be because:

e The DNS server could not be found.
¢ There is no connection to the network.

* The specified DNS server could not be con-
nected to.
* Incorrect DNS server is specified.

* Nospecified SMTP server IP address in the
DNS server.

Frametype =<frame type name>

The <frame type name> is configured to be
used on NetWare.

httpd start.

An httpd has started.

IEEE 802.11b current channel <Channel>

The current channel is displayed.

The value chosen by the user is displayed in ad
hoc mode.

The channel used in the access point is dis-
played in infrastructure mode.

(Example: Current channel is 11.)
IEEE 802.11b current channel 11
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Message

Description and Solutions

IEEE 802.11b MAC Address = <MAC Ad-
dress>

The IEEE 802.11b I/F MAC address is dis-
played.

(Example: Current MAC address is
00:00:74:XX:XX:XX.)

IEEE 802.11b MAC Address =
00:00:74:XX:XX: XX

IEEE 802.11b SSID <ssid> (AP MAC Address
<MAC Address>)

The SSID of the access point used in infrastruc-
ture mode and the MAC address of the access
point are displayed.

(Example: Current MAC address is
XX:xx:xx:xx:xx:xx and SSID value is "test-ssid".)
IEEE 802.11b SSID test-ssid (AP MAC Address
XXEXXEXX XX XX XX)

IEEE 802.11b Tx Rate <Transfer Speed>

The IEEE 802.11b transmitting speed (set
speed) is displayed.

(Example: Current Tx Rate is 11Mbps.)
IEEE 802.11b Tx Rate 11Mbps

inetd start.

An inetd has started.

<interface> started with IP: <IP address>

<IP address> has been set for <Interface> and
<Interface> started.

<Interface>: Subnet overlap.

Subnet from Netmask and the IP address you
tried to set for <Interface> overlap the subnet
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.

IPP job canceled. jobid=&percnt;d.

The spooled job has been canceled due to an
error or by user request.

job canceled. jobid=&percnt;d.

The spooled job has been canceled due to an
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from
the DHCP server is <lease time> in seconds.
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name>
(<IPX11P>,<NDS | BINDERY>)

(In print server mode) Logged in to the file
server with NDS or BINDERY mode.

multid start.

Data transmission service for multiprotocols
has started.
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Message

Description and Solutions

nbstart start. (NetBEUT)

The service for NetBEUI protocol stack setting
has started.

NBT Registration Broadcast(<NetBIOS
name>)

Use alocal broadcast to map <NetBIOS name>
with the IP address.

nbtd start.

A nbtd (NetBIOS over TCP/IP Daemon) has
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer
name>

The NetBEUI Computer Name is defined as
<computer name>.

nmsd start. (NetBEUI)

A nmsd (Name Server Daemon) has started.

no smtp server. connection close.

No response from the SMTP protocol. Cannot
connect to the SMTP server. This could be be-
cause:

e Another server other than the SMTP server
has been specified.

¢ The SMTP server port number is incorrect.

npriter start. (NetWare)

(In remote printer mode) NetWare service has
started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.

Open log file <file name>

(In print server mode) The specified log file
has been opened.

papd start. (AppleTalk)

AppleTalk print service has started.

permission denied.

Job cancellation was determined to be unau-
thorized after checking the user name and host
address (except for ROOT authorization).

phy release file open failed.

Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In print server mode) The print queue name
cannot be serviced. Make sure that print queue
volume exists on the specified file server.

Print server <print server name> has no print-
er.

(In print server mode) The printer object is not
assigned to the print server <print server
name>. Using NWAdmin, assign the printer
object, and then restart the printer device.

Print session full

Cannot accept the print session.

Printer <printer name> has no queue

(In print server mode) The print queue is not
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare)

(In print server mode) NetWare service has
started.
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refused connect by smtp server.

The connection to the SMTP server is denied.
This could be because:

e Another server other than the SMTP server
has been specified.

¢ The SMTP server port number is incorrect.

Required computer name (<Computer
name>) is duplicated name

The same computer name is detected on the
network. The start job determines the compu-
ter name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

Required file server (<file server name>) not
found

Cannot find the required file server.

restarted.

LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name>

A <NDS context name> has been set.

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUTI)

An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready.

Communication over TCP/IP with SNMP is
available.

Snmp over IP over 1394 is ready.

Communication over IP over 1394 with SNMP
is available.

Snmp over ipx is ready.

Communication over IPX with SNMP is avail-
able.

snmpd start.

SNMP service has started.

started.

Direct print service has started.

The print server received error <error
number> during attempt to log in to the net-
work.Access to the network was denied. Verify
that the print server name and password are
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without
specifying a password.

username or password wasn't correct.

Failure to establish a connection with the
SMTP server. The following causes can be at-
tributed.

e Incorrect SMTP user name assigned.

¢ Incorrect SMTP password assigned.

win2kspd protocol-DOWN (APPEXIT).

NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.
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win2kspd protocol-UP (APPENTRY).

NVRAM setting ioctl (SPIO CAPPENTRY) of
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

win2kspd started.

SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response

There has been no response to the update re-
quest from the server. Confirm that the WINS
server address is correct and the WINS server
is working properly.

WINS name registration/refresh error code
<error number>

Set unique (not shared) NetBIOS names.

Confirm the WINS server address is correct
and working properly.

WINS name registration:Server No Response

There has been no response to the registration
request from the server. Confirm that the
WINS server address is correct and the WINS
server is working properly.

WINS server address0.0.0.0

The WINS server address has not been speci-
fied. Specify the WINS server address to
match the printer name with WINS.

WINS Server=<WINS server address> NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopelD

The scope ID is wrong.
Specify the correct scope ID.

write error occurred. (diskfull)

The hard disk became full while the spool file
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal)

A fatal error occurred while the spool file was
being written.

Turn the printer off and then on. If this does
not work, contact your service or sales repre-
sentative.




Precautions

Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

& Note

O The MAC address of the printer doing the filtering is printed on the printer
configuration page. For more information about printing a configuration
page, see the Setup Guide.

O For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

ﬂ Following the setup method in this manual, configure the file server.
g Set the frame type for a NetWare environment.

A Reference
For more information about selecting a frame type, see the Setup Guide.

Configuring the printer without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

A Reference
For more information about selecting a protocol, see the Setup Guide.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tions Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.

e With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e With Windows 2000/ XP /Server 2003, clear the [Form feed] check box on the
[NetWare Settings] tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]
tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

e With Windows 2000/ XP/Server 2003, clear the [Enable banner] check box on
the [NetWare Settings] tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print.
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Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

If you connect an Ethernet interface and IEEE 1394 (IP over 1394) interface simul-
taneously, pay attention to the following;:

% When a static IP address is set for both interfaces

o [P Address: If interface IP addresses overlap, the Ethernet interface is se-
lected.

* Subnet Mask: If interface subnet masks overlap, the Ethernet interface is
selected.

* Gateway Address: The selected value is applied.

& Note
O Make the gateway address setting inside the subnet set in the interface.

O If a value is beyond the range of the subnet selected by the interface, the
machine operates with "0.0.0.0".
< When obtaining addresses from the DHCP server

e IP Address, Subnet Mask: You can configure addresses assigned by a
DHCP server.

@ Note

O If IP addresses overlap or the same subnet IP addresses are selected, the
effective value is assigned only to the prioritized interface.

O Default interface priority is Ethernet.
¢ AutoNet: A temporary IP address starting with 169.254 that is not used on
the network, assigned to the prioritized interface.

& Note
O Default interface priority is IEEE 1394 (IP over 1394).

* Gateway Address, DNS Server Address, and Domain Name: You can con-
figure the addresses assigned by DHCP to the prioritized interface.

& Note
O Default interface priority is Ethernet.
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< When there are static IP addresses and addresses assigned by DHCP

¢ JP Address and subnet mask: If a static IP address is the same as an address
assigned by DHCP, or the static subnet mask address and the subnet mask
address assigned by DHCP overlap, the machine uses the static IP address
interface.

& Note
O The interface with the DHCP setting is set by default.

* Gateway Address: Operates with the address entered manually.

@ Note

O If a static address is not selected, or is set to 0.0.0.0, the interface with the
address assigned by DHCP is used.

& Note

O Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server. See p.117 “WINS”.

O Supported DHCP servers are Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000, Windows XP Professional / Windows Server 2003 Server, and
NetWare 5/5.1, 6.

O If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so that the same IP address is assigned every time.

O To use the WINS server, change the WINS server setting to “active” using the
control panel.

O Using the WINS server, you can configure the host name via the remote net-
work printer port.

O DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

& Note
O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the configuration page. For more
information about the configuration page, see the Printer Reference.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

O The machine cannot communicate with devices that do not have the AutoNet
function.
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Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartNetMonitor for Admin even under a DHCP environment.

This section describes how to configure the WINS server.

& Note

O The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or
later, and Windows 2000 Servers WINS Manager.

O For more information about the WINS Server settings, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.

Using a Web browser

ﬂ Start the Web browser.

gPoint your browser at the URL or IP address of the printer (e.g. ht-
tp /XXX XXX XXX XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

B Ciick [Administrator Mode].
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click OK.

To use the factory default account, enter no user name and type "password"
for the password.

B Point to [Configuration], [Network], [Protocol], and then click [TCP/IP].

E Set WINS to [Enable] and enter the IP address of the WINS server in [Primary
WINS Server;] and [Secondary WINS Server] boxes.

0 crick [Apply].
B Quit the Web browser.
g Exit the Web browser.
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Using telnet

ﬂ Connect to the remote printer using telnet.

g Use the "set" command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following com-
mands.
msh> wins primary Ipaddress msh> wins secondary Ipaddress

& Note
O To confirm the current configuration, use the "show" command.

ﬂ Log out from telnet.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client

When using IPP with SmartNetMonitor for Client, note the following;:

* The network printer can only receive one print job from SmartNetMonitor for
Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

¢ If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

* If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

* Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

e If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were
sent.

e AnIP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.
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Specifications

Interface

100BASE-TX, 10BASE-T, IEEE 1394 (IP over 1394) !, IEEE 802.11b

Frame type

Ethernetll, IEEE 802.2, IEEE 802.3, SNAP

Protocol

e TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP/Server 2003
Windows NT 4.0

e IPX/SPX
NetWare 3.12,3.2,4.1,4.11,4.2,5, 5.1, 6, IntranetWare

e NetBEUI 2
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

e IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP/Server 2003
Windows NT 4.0

e SMB
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP/Server 2003
Windows NT 4.0

¢ AppleTalk
Mac OS 8.6 or later
Mac OS X 10.1 or later

SNMP

MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

' The 1394 Interface Unit Type 4510 supports TCP/IP and IPP.
"2 To use NetBEUI, use the SmartNetMonitor for Client port.
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